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Chapter 528

Superiority by a Margin
Tests for the Difference
of Two Means in a
Higher-Order CrossOver Design
Introduction
This procedure calculates power and sample size for non-zero null tests which use the difference in the means of a
higher-order cross-over design. Measurements are made on individuals that have been randomly assigned to one of
several treatment sequences. Only a brief introduction to the subject will be given here. For a comprehensive
discussion on the subject, refer to Chen et al. (1997) and Chow et al. (2003).

Cross-Over Designs
Senn (2002) defines a cross-over design as one in which each subject receives all treatments at least once and the
object is to study differences among the treatments. The name cross-over comes from the most common case in
which there are only two treatments. In this case, each subject crosses over from one treatment to another. It is
assumed that there is a washout period between treatments during which the response returns to its baseline value.
If this does not occur, there is said to be a carryover effect.
A 2x2 cross-over design refers to two treatments (periods) and two sequences (treatment orderings). One
sequence of treatments is treatment A followed by treatment B. The other sequence is B and then A. The design
includes a washout period between responses to make certain that the effects of the first drug do no carryover to
the second. Thus, the groups of subjects in this design are defined by the sequence in which the two treatments are
administered, not by the treatments they receive.

Higher-Order Cross-Over Designs
Chen et al. (1997) present the results for four cross-over designs that are more complicated than the 2x2 design.
Assume that the two treatments are labeled A and B. The available designs are defined by the order and number
of times the two treatments are administered.
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Balaam’s Design
Balaam’s design has four sequences with two treatments each. It is popular because it allows the intrasubject
variabilities to be estimated. The design is
Sequence
1
2
3
4

Period 1
A
B
A
B

Period 2
A
B
B
A

Two-Sequence Dual Design
This design has two sequences with three periods each. It is popular because it allows the intrasubject variabilities
to be estimated. The design is
Sequence
1
2

Period 1
A
B

Period 2
B
A

Period 3
B
A

Four-Period Design with Two Sequences
This design has two sequences of four periods each. The design is
Sequence
1
2

Period 1
A
B

Period 2
B
A

Period 3
B
A

Period 4
A
B

Four-Period Design with Four Sequences
This design has four sequences of four periods each. The design is
Sequence
1
2
1
2

Period 1
A
B
A
B

Period 2
A
B
B
A

Period 3
B
A
B
A

Period 4
B
A
A
B

Advantages of Cross-Over Designs
A comparison of treatments on the same subject is expected to be more precise. The increased precision often
translates into a smaller sample size. Also, patient enrollment may be easier to obtain because each patient will
receive both treatments.

Disadvantages of Cross-Over Designs
The statistical analysis of a cross-over experiment is more complex than a parallel-group experiment and requires
additional assumptions. In a cross-over experiment, it may be difficult to separate the treatment effect from the
time effect and the carry-over effect of the previous treatment.
These cross-over designs cannot be used when the treatment (or the measurement of the response) alters the
subject permanently. Hence, it cannot be used to compare treatments that are intended to provide a cure.
Because subjects must be measured at least twice, it may be more difficult to keep patients enrolled in the study.
This is particularly true when the measurement process is painful, uncomfortable, embarrassing, or time
consuming.
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The Statistical Hypotheses
Both non-inferiority and superiority tests are examples of directional (one-sided) tests. Remember that in the
usual t-test setting, the null (H0) and alternative (H1) hypotheses for one-sided tests are defined as

H 0 :δ ≤ A versus H1:δ > A
Rejecting H0 implies that the mean is larger than the value A. This test is called an upper-tailed test because H0 is
rejected only in samples in which the difference in sample means is larger than A.
Following is an example of a lower-tailed test.

H 0 :δ ≥ A versus H1:δ < A
Non-inferiority and superiority tests are special cases of the above directional tests. It will be convenient to adopt
the following specialize notation for the discussion of these tests.
Parameter

PASS Input/Output Interpretation

µT

Not used

Treatment mean. This is the treatment mean.

µR

Not used

Reference mean. This is the mean of a reference population.

Ms

SM

Margin of superiority. This is a tolerance value that defines the
magnitude of difference that is required for practical importance. This
may be thought of as the smallest difference from the reference that is
considered to be different.

δ

D

True difference. This is the value of µT − µ R , the difference between the
treatment and reference means. This is the value at which the power is
calculated.

Note that the actual values of µT and µ R are not needed. Only their difference is needed for power and sample
size calculations.

Superiority by a Margin Tests
A superiority test tests that the treatment mean is better than the reference mean by more than the superiority
margin. The actual direction of the hypothesis depends on the response variable being studied.

Case 1: High Values Good
In this case, higher values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the treatment mean is greater than the reference mean by at least the margin of superiority. The value of δ must
be greater than M S . The following are equivalent sets of hypotheses.

H 0 :µ1 ≤ µ 2 + M S versus

H 1 :µ1 > µ 2 + M S

H 0 :µ1 − µ 2 ≤ M S versus

H 1 :µ1 − µ 2 > M S

H 0 :δ ≤ M S

H 1 :δ > M S

versus
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Case 2: High Values Bad
In this case, lower values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the treatment mean is less than the reference mean by at least the margin of superiority. The value of δ must be
less than − M S . The following are equivalent sets of hypotheses.

H 0 :µ1 ≥ µ 2 − M S

versus H 1 :µ1 < µ 2 − M S

H 0 :µ1 − µ 2 ≥ − M S versus H 1 :µ1 − µ 2 < − M S
H 0 :δ ≥ − M S

versus H 1 :δ < − M S

Test Statistics
The analysis for assessing non-inferiority and non-zero null tests using higher-order cross-over designs is
discussed in detail in Chapter 9 of Chow and Liu (2000). Unfortunately, their presentation is too lengthy to give
here. Their method involves the computation of an analysis of variance to estimate the error variance. It also
describes the construction of confidence limits for appropriate contrasts. One-sided confidence limits can be used
for non-inferiority tests. Details of this approach are given in Chapter 3 of Chow et al. (2003). We refer you to
these books for details.

Power Calculation
The power of the non-inferiority and superiority tests for the case in which higher values are better is given by

 δ − ε 

Power = TV  
 − tV ,1−α 
  σW b / n 

where T represents the cumulative t distribution, V and b depend on the design, σ W is the square root of the within
mean square error from the ANOVA table used to analyze the cross-over design, and n is the average number of
subjects per sequence. Note that the constants V and b depend on the design as follows.
The power of the non-inferiority and superiority tests for the case in which higher values are worse is given by


 ε − δ 
Power = 1 − TV  tV ,1−α − 

 σ W b / n  

The constants V and b depend on the design as follows:
Design Type

Parameters (V,b)

Balaam’s Design

V = 4n – 3, b = 2.

Two-Sequence Dual Design

V = 4n – 4, b = 3/4.

Four-Period Design with Two Sequences

V = 6n – 5, b = 11/20.

Four-Period Design with Four Sequences

V = 12n – 5, b = 1/4.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power for a power analysis or Sample Size for sample size determination.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Note that there are two choices for finding Sample Size. Select Sample Size (Equal Per Sequence) when you want
the design to have an equal number of subjects per sequence. Select Sample Size (Exact) when you want to find
the exact sample size even though the number of subjects cannot be dividing equally among the sequences.
Select Power when you want to calculate the power of an experiment.

Test
Design Type
Specify which cross-over design that you want to analyze. These designs allow you to compare two means: a
treatment (A) and a reference (B). The designs assume that each subject is measured two or more times (or
periods) with ample time in between to wash-out the effect of the treatment.
A sequence is an ordering of the how A and B are applied. For example, 'ABA' means that the subjects are
measured three times: first treatment A, then B, then A again. Other possible sequences are BAB, AAB, and
BBA. Each design includes several sequences.
The design tries to balance the experiment so that each treatment occurs an equal number of times and after each
other treatment an equal number of times.
Higher Means Are
This option defines whether higher values of the response variable are to be considered better or worse. The
choice here determines the direction of the test.
If Higher Means Are Better the null hypothesis is Diff ≤ SM and the alternative hypothesis is Diff > SM. If
Higher Means Are Worse the null hypothesis is Diff ≥ SM and the alternative hypothesis is Diff < SM.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Total Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study (total subjects
in all sequences). This value must be an integer greater than one.
You may enter a list of values using the syntax 50,100,150,200,250 or 50 to 250 by 50.

Effect Size – Mean Difference
|SM| (Superiority Margin)
This is the magnitude of the margin of superiority. It must be entered as a positive number.
When higher means are better, this value is the distance above the reference mean that is required to be considered
superior. When higher means are worse, this value is the distance below the reference mean that is required to be
considered superior.
D (Difference, μT - μR)
This is the actual difference between the treatment mean and the reference mean at which the power is calculated.
When higher means are better, this value should be greater than SM. When higher means are worse, this value
should be negative and greater in magnitude than SM.

Effect Size – Standard Deviation
Specify σ as σw or σb and ρ
This option specifies how you will enter the within standard deviation, σw. You have two choices:
σw
Specify σw directly.
σb and ρ
Specify σb and ρ separately. The value of σw is calculated using the formula: σw = σb √(1 - ρ).
σw (Within Std Dev)
Specify the value(s) of the standard deviation σw. This value can be estimated using σw = √(WMSE) where
WMSE is the within mean square error from the ANOVA table used to analyze the Cross-Over design.
If you were to compute the treatment difference for each subject, this would be the standard deviation of those
differences. These values must be positive.
A list of values may be entered.
You can press the σ button to load the Standard Deviation Estimator window.
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σb (Between Std Dev)
This is the between subject standard deviation of the response variable (Y) at a particular time point. It is assumed
to be the same for all time points. This represents the variability from subject to subject that occurs when the
subjects are treated identically.
As a standard deviation, the number(s) must be greater than zero.
You can enter a list of values separated by blanks or commas, in which case, a separate analysis will be calculated
for each value.
You can press the σ button and select 'Covariance Matrix' to obtain help on estimating the standard deviation from
an ANOVA table.
ρ (Correlation)
Specify the correlation between two observations made on the same subject. Negative values are not permitted, so
it must be between 0 and 1. When no previous information is available, try values between 0.2 and 0.6.
You can press the σ button and select 'Covariance Matrix' to obtain help on estimating the standard deviation
from an ANOVA table.
You can enter a single value or a list of values.
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Example 1 – Finding Power
Researchers want to calculate the power of a non-zero null test using data from a two-sequence, dual cross-over
design. The margin of superiority is either 5 or 10 at several sample sizes between 6 and 66. The true difference
between the means under is assumed to be 15. Similar experiments have had a standard deviation (σw) of 10. The
significance level is 0.025.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Difference of Two Means in a Higher-Order CrossOver Design procedure window by expanding Means, then Cross-Over (Higher-Order) Design, then clicking
on Superiority by a Margin, and then clicking on Superiority by a Margin Tests for the Difference of Two
Means in a Higher-Order Cross-Over Design. You may then make the appropriate entries as listed below, or
open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Design Type ............................................ 3x2 (Three-Period, Two-Sequence Dual: ABB|BAA)
Higher Means Are ................................... Better
Alpha ....................................................... 0.025
N (Total Sample Size)............................. 6 to 66 by 10
|SM| (Superiority Margin) ........................ 5 10
D (True Difference) ................................. 15
Specify σ as σw or σb and ρ................... σw (Within Std Dev)
σw (Within Std Dev) ................................ 10

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Superiority Test of the Mean Difference in a Three-Period, Two-Sequence Dual Design
Treatment Sequences: ABB | BAA
Hypotheses: H0: D = (μT - μR) ≤ SM; H1: D = (μT - μR) > SM
Higher Means are Better

Power
0.3837
0.1139
0.8832
0.3405
0.9818
0.5282
0.9975
0.6744
0.9997
0.7817
1.0000
0.8571
1.0000
0.9084

Total
Sample
Size
N
6
6
16
16
26
26
36
36
46
46
56
56
66
66

Superiority
Margin
SM
5.000
10.000
5.000
10.000
5.000
10.000
5.000
10.000
5.000
10.000
5.000
10.000
5.000
10.000

Mean
Difference
D (μT-μR)
15.000
15.000
15.000
15.000
15.000
15.000
15.000
15.000
15.000
15.000
15.000
15.000
15.000
15.000

Within
Standard
Deviation
σw
10.0000
10.0000
10.0000
10.0000
10.0000
10.0000
10.0000
10.0000
10.0000
10.0000
10.0000
10.0000
10.0000
10.0000

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
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Report Definitions
Power is the probability of rejecting H0 (concluding non-inferiority) when H0 is false.
N is the total number of subjects. They are divided evenly among all sequences.
μT is the treatment mean. It is usually associated with the letter 'A' in the design.
μR is the reference mean. It is usually associated with the letter 'B' in the design.
SM is the magnitude of the margin of superiority. Since higher means are better, this value is positive and is
the distance above the reference mean that is required to be considered superior.
D (μT - μR) is the mean difference at which the power is computed. D = treatment mean - reference mean.
σw is the square root of the within mean square error from the ANOVA table.
Alpha is the probability of falsely rejecting H0 (falsely concluding superiority).
Summary Statements
In a superiority test on data for which higher values are better drawn from a three-period,
two-sequence dual cross-over design, a total sample size of 6 achieves 38% power at a 2.5%
significance level when the true difference between the means is 15.000, the superiority margin
is 5.000 and the within-subject standard deviation is 10.0000.

This report shows the power for the indicated scenarios.

Plots Section

These plots show the power versus the sample size.
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Example 2 – Finding Sample Size
Continuing with Example 1, the researchers want to find the exact sample size needed to achieve both 80% power
and 90% power.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Difference of Two Means in a Higher-Order CrossOver Design procedure window by expanding Means, then Cross-Over (Higher-Order) Design, then clicking
on Superiority by a Margin, and then clicking on Superiority by a Margin Tests for the Difference of Two
Means in a Higher-Order Cross-Over Design. You may then make the appropriate entries as listed below, or
open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size (Exact)
Design Type ............................................ 3x2 (Three-Period, Two-Sequence Dual)
Higher Means Are ................................... Better
Power ...................................................... 0.80 0.90
Alpha ....................................................... 0.025
|SM| (Superiority Margin) ........................ 5 10
D (True Difference) ................................. 15
Specify σ as σw or σb and ρ................... σw (Within Std Dev)
σw (Within Std Dev) ................................ 10

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Superiority Test of the Mean Difference in a Three-Period, Two-Sequence Dual Design
Treatment Sequences: ABB | BAA
Hypotheses: H0: D = (μT - μR) ≤ SM; H1: D = (μT - μR) > SM
Higher Means are Better

Power
0.8032
0.8073
0.9023
0.9041

Total
Sample
Size
N
13
49
17
65

Superiority
Margin
SM
5.000
10.000
5.000
10.000

Mean
Difference
D (μT-μR)
15.000
15.000
15.000
15.000

Within
Standard
Deviation
σw
10.0000
10.0000
10.0000
10.0000

Alpha
0.025
0.025
0.025
0.025

When the superiority margin is set to 10, 65 subjects are needed to achieve 90% power and 49 subjects are needed
to achieve at least 80% power.

Example 3 – Validation
This procedure uses the same mechanics as the Non-Inferiority Tests for the Difference of Two Means in a
Higher-Order Cross-Over Design procedure. We refer the user to Example 3 of Chapter 530 for the validation.
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